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1. Overview 
The SL-881 6G Handheld HDMI/MHL Audio Video Generator (SL-881 AVG, SL-881, or AVG) is designed for testing 
source, sink, or repeater devices, and is compliant to the latest High Definition Multimedia Interface (HDMI®) 2.0a and 
Mobile High-Definition Link (MHL®) 3.x specifications. 

This User Guide provides details on how to setup and test source, sink, or repeater devices for compliance to the HDMI 
version 2.0a and MHL 3.x specifications. 

For the latest updated software, drivers, see online at:  

https://www.simplaylabs.com/Support/ 

For the latest updated documentation, see online at : 

https://www.simplaylabs.com/Support/Documentation/ 

 

 SL-881  Hardware 
Figure 1.1, Figure 1.2, and Figure 1.3 show the top view, the front panel view, and the rear panel view of the SL-881 
AVG chassis, respectively. 

 

Figure 1.1. SL-881 AVG − Top View 

 

Figure 1.2. SL-881 AVG − Front Panel 

https://www.simplaylabs.com/Support/
https://www.simplaylabs.com/Support/Documentation/
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Figure 1.3. SL-881 AVG − Rear Panel 

 SL-881 Controls, Indicators, and Interface Connectors 
Figure 1.4 shows the location of the SL-881 AVG enclosure features: input and output ports, power and reset switches, 
LCD touch screen display, and SD card slot. 
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Figure 1.4. Locating SL-881 AVG Components − Top View 
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Item Label Description 

1 +5 V DC DC power receptacle, 5 V 3 A. 

2 Power Switch Powers On/Off switch. 

3 USB USB mini-B port. Connects to test computer before running SCDC CTS test. 

4 SPDIF OUT SPDIF output port. 

5 SPDIF IN SPDIF input port. 

6 HDMI OUT2 (3G)  HDMI 2.0a 3G signal generator port 2. 

7 HDMI OUT1 (6G) HDMI 2.0a 6G signal generator port 1. 

8 HDMI INPUT HDMI 2.0a signal receiver port. 

9 MHL OUT MHL signal output port. 

10 I2C Monitor Test connector for SCDC CTS test and DDC monitor function. 

11 UPG Push-button switch for firmware upgrade. 

12 SD Card  SD card slot, only for updating firmware, and supplying audio and EDID contents from an 
up to 32 GB SD card. 

13 Reset Reset button 

14 LED Charger Battery charging indicator: when green, the SL-881 battery is charging. Turns off when the 
battery charge is complete. 

15 LED Power DC power indicator: when red, the power adapter is connected and the SL-881 is powered 
on. 

16 LCD Touch Screen  Enables SL-881operation in standard test mode. See Section 1.3.1.2 for a description of 
the touch screen icons and their functions. 

 SL-881 Test Modes 
The SL-881 AVG is designed to offer two distinct modes of operation: 

• Standard Test Mode, see Section 1.3.1. 

• Enhanced Test Mode, adding to the standard mode functionality. See Section 1.3.2. 

1.3.1. Standard Test Mode 

In its standard test configuration, the SL-881 offers audio and video test features to enable compliance testing to HDMI 
2.0a and MHL 3.x specifications. 

1.3.1.1. Available Standard Tests 

The SL-881 AVG is ready for use in standard test mode immediately upon delivery. These are the operations that are 
available in standard test mode: 

1. Analyze input signal using HDMI IN port 

2. Generate output signal using HDMI OUT ports 

3. Perform Factory timing test using HDMI OUT ports 

4. Read EDID contents from devices connecting to HDMI OUT ports 

5. Load EDID data to HDMI IN port  

For details of the above operations, refer to Section 2. 
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1.3.1.2. The SL-881 LCD Touch Screen in Standard Test Mode 

Figure 1.5 shows the LCD touch screen of the SL-881 in standard test mode under default factory configuration. 

Home

Video Generator Video Analyzer EDID Read EDID Load

Factory Test Settings

 

Figure 1.5. LCD Touch Screen Main Window 

These are the standard operation features, accessible through the icons that are displayed on the LCD touch screen of 
the SL-881: 

 

Icon Function Section Reference 

Video Generator Controls HDMI OUT 1 and HDMI OUT 2 ports to send HDMI signal. Section 2.2 

Video Analyzer Analyzes HDMI input signal from HDMI IN port. Section 2.3 

EDID Read Reads EDID contents from device connected to HDMI OUT 1 (6G) or 
HDMI OUT 2 (3G) port. 

Section 2.4 

EDID Load Loads EDID data from SD card and program to HDMI INPUT port. Section 2.5 

Factory Test Runs batch testing for a device connected to HDMI OUT 1 or HDMI 
OUT 2 ports. 

Section 2.6 

Settings Displays AVG firmware-related information. LCD touch screen to list 
current settings and parameters. 

— 

1.3.2. Enhanced Test Mode 

Enhanced test mode features become available only when installing optional software to your test computer. Section 3 
gives details of the procedure for installing the software and registering the license that is required to run the 
expanded test features. Section 4 gives details on the enhanced SL-881 AVG functionality. 

1.3.2.1. Enhanced Test Functions 

In addition to the full set of functions of the standard configuration, enhanced test functionality becomes available 
upon installation and licensing of the optional software. These enhanced functions become available: 

1. Perform EDDC (SCDC) compliance test. 

2. Perform cable loop-back test. 

3. DDC monitoring 

4. EDID file editing 

For details of the above operations, see Section 4. 
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1.3.3. Devices under Test 

Standard and enhanced test operations are available for: 

• Sink devices, or input port of repeater devices 

• Source devices, or output port of repeater device 

 Inside the Box 
The SL-881 AVG delivery includes the following items: 

• 5 V power supply 

• Prime pass HDMI cable 

• USB A to USB mini-B cable 

• MHL cable (HDMI to Mini-B USB) 

• SD card. This card is required to transfer and program the EDID contents of the HDMI INPUT port, and also for 
firmware upgrading. 

• Header cable, 10 pin, with daughter card. IMPORTANT! Save this item, as it is required for operation in the 
enhanced SL-881 AVG test mode. 
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2. The SL-881 in Standard Test Mode 
In its standard test configuration, the SL-881 offers audio and video test features to enable compliance testing to  
HDMI 2.0a and MHL 3.x specifications. 

For standard mode operation, no additional optional software installation is required. 

These are the operations that are available in the standard test mode: 

1. Generate output signal using HDMI OUT ports 

2. Analyze input signal using HDMI IN port 

3. Perform Factory timing test using HDMI OUT ports 

4. Load EDID data to HDMI IN port  

5. Read EDID contents from devices connecting to HDMI OUT ports 

Notes: When in Standard test mode, testing with source device or the output port of repeater 
devices, you can perform actions 2 and 4 mentioned in Section 2.3 and Section 2.5. 

When in Standard test mode, testing with sink device or the input port of repeater 
devices, you can perform actions 1, 3, and 5 mentioned in Section 2.2, Section 2.6, and 
Section 2.4. 

 Setting up Connections 
Connect the SL-881 to the source device or the output port of the repeater or sink device or the input port of the 
repeater device before performing any test. 

• When testing with HDMI Source device or the output port of repeater device, connect the SL-881 to your source 
device in the way shown in Figure 2.1. 

HDMI Source Device

HDMI Cable

 

Figure 2.1. Connecting with HDMI Source Device in Stand-alone Mode 

• When testing with HDMI Sink device or the input port of the repeater device, connect the SL-881 to your sink 
device in the way shown in Figure 2.2. 

HDMI Cable

HDMI Sink Device

 

Figure 2.2. Connecting with HDMI Sink Device in Stand-alone Mode 
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• When testing with MHL Source device, connect the SL-881 to your MHL source device in the way shown in Figure 
2.3. 

MHL Source Device

MHL Cable

 

Figure 2.3. Connecting with MHL Source Device in Stand-alone Mode 

• When testing with MHL Sink device, connect the SL-881 to your MHL sink device in the way shown in Figure 2.4. 

MHL Sink Device

MHL Cable

 

Figure 2.4. Connecting with MHL Sink Device in Stand-alone Mode 

 Generating Video Signals When Running with Sink Devices  
The SL-881 can be used to generate multiple output signals to sink devices or the input port of repeater devices. You 
can modify parameters of the output signal at run time. 

This procedure shows how to generate output signal when running with a sink device. 

1. Use the HDMI cable to connect the HDMI sink device to the SL-881 HDMI OUT 1 port, as shown in Figure 2.2. 

Or, use the MHL cable to connect the MHL sink device to the SL-881 MHL OUT port if you test an MHL sink device, 
as shown in Figure 2.4. 

2. Power on the SL-881. 

3. On the LCD touch screen (Figure 1.5), choose Video Generator. The Video Generator window appears (Figure 2.5). 
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Video Generator

1.4b Default

2.0 Default

Resolution

480P

Signal Type

Auto

Color Space

RGB

Audio Source

Internal I2S

Video Pattern

Color Bars

HDCP

Auto

Color Depth

8-bit

HDR

Off

EDID Header Check: Fail
HDCP FAIL

EDID HDR Support: No

 

Figure 2.5. Video Generator Window 

Field Function 

Resolution Change output video timings, from 480p to 4k 

Video Pattern Change output video patterns, up to 30 video patterns are supported 

Signal Type Change output mode HDMI/DVI 

HDCP Change output HDCP revision, HDCP 2.x / 1.x / Off 

Color Space Change output color spaces, RGB/YC444/YC422/YC420 

Color Depth Change output color depth, 8/10/12 bits per pixel per channel 

Audio Source Change output audio formats 

HDR Change output HDR formats enable/disable 

  

You can choose the parameter you want to change from the Video Generator window, such as Resolution. Change the 
parameter. The output signal will be changed accordingly. 
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 Analyzing Input Signal When Running with Source Devices 
The SL-881 can be used to analyze input signal from source devices or from output port of repeater devices, including 
video timing, video format, audio format, and HDR infoFrame information.  

The following procedure shows how to analyze the video timing for input signal when running with source devices.  

1. Use the HDMI cable to connect HDMI source device to the SL-881 HDMI IN port, as shown in Figure 2.1. 

Or, use the MHL cable to connect MHL source device to the SL-881 HDMI IN port when you test an MHL source 
device, as shown in Figure 2.3. 

2. Power on the SL-881. 

3. On the LCD touch screen (Figure 1.5), choose Video Analyzer. The Video Analyzer window appears (Figure 2.6). 

Video Analyzer

Pixel Freq I / P

Hpol Vpol

Htotal

Hactive

Hsync

Hfront

Vtotal

Vactive

Vsync

Vfront

N/A

HDMI

N/A

Video FormatVideo Timing Audio Format HDR Info

 

Figure 2.6. Video Analyzer Window 

Field Function 

Pixel Freq detected pixel frequency (Hz) 

I/P detected Interlaced/Progressive mode 

Hpol detected timing Hsync polarities 

Vpol detected timing Vsync polarities 

Htotal detected timing Horizontal total pixel count 

Vtotal detected timing Vertical total pixel count 

Hactive detected timing Horizontal active pixel count 

Vactive detected timing Vertical active pixel count 

Hsync detected timing Hsync width (in pixels) 

Vsync detected timing Hsync width (in lines) 

Hfront detected timing Hsync front pixels 

Vfront detected timing Vsync front lines 
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 Reading EDID Contents from HDMI OUT Ports 
The SL-881 can be used to read EDID contents from a sink device or the input port of repeater device. The 256-byte raw 
data, which is in Hex mode, of EDID contents from a sink device or input port of a repeater device can be read out and 
displayed in the LCD touch screen of the SL-881 in this test.  

This procedure shows how to read EDID contents from the HDMI OUT ports. 

1. Use the HDMI cable to connect the sink device to the SL-881 HDMI OUT 1 port, as shown in Figure 2.2. 

2. Power on the SL-881. 

3. On the LCD touch screen (Figure 1.5), choose EDID Read. The Read EDID from Sink DUT window appears  
(Figure 2.7). 

Read EDID from Sink DUT (From HDMI OUT1)
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Figure 2.7. Read EDID from Sink DUT Window 

You can use the Block 0 or Block 1 tab to select which part of EDID contents to display. Use the Refresh button to read 
EDID contents from the HDMI OUT 1 port. Use the Write button to program current EDID content to AVG HDMI IN port. 
Use the Save button to save current EDID content to SD card. 
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 Loading EDID Data to the HDMI IN Port 
The EDID contents of HDMI input port of the SL-881 can be updated using SD card. Use the EDID Load icon of the  
SL-881 LCD touch screen (Figure 1.5) to load the updated EDID file from the SD card. 

Note: When you want to update the EDID content of the HDMI input of the SL-881, copy your 
own EDID data, 256-byte binary file in *.bin format to the SD card. 

This procedure shows how to load EDID data from the SD card to the HDMI IN port of the SL-881. 

1. Power on the SL-881. 

2. Plug the SD card into the SD Card slot. 

3. On the LCD touch screen (Figure 1.5), choose EDID Load. The Load EDID to Sink TE window appears. See Figure 2.8. 

Load EDID to Sink TE

16%

Refresh

Local Disks

SD Card

EDID_data.bin
Load File

Cancel

 

Figure 2.8. Load EDID to Sink TE Window 

4. Select the EDID file (EDID_data.bin) to load. 

5. Select Load File or Cancel from the pop-up menu that is not visible on screen. If you click Load File, the selected 
EDID file will be loaded into HDMI IN port of the SL-881. If you do not want to load the selected EDID file, click 
Cancel. 

6. Use the HDMI cable to connect source device to the SL-881 HDMI IN port, as shown in Figure 2.1. Now the source 
device is tested with the new loaded EDID content.  

Note: When the pop-up menu appears, you cannot go back to the main window until you click 
Load File or Cancel. Use the Home icon on the upper right corner to go back to the main 
window. 
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 Performing Factory Test When Running with Sink Devices 
The SL-881 can be used to perform video output batch testing, using the Factory Test icon of the SL-881 LCD touch 
screen. You can perform a quick check for input signal rendering capability of your Sink device or input port of the 
repeater device. 

This procedure shows how to perform factory test when running with sink devices. 

1. Use the HDMI cable to connect sink device to the SL-881 HDMI OUT 1 port, as shown in Figure 2.2. 

2. Power on the SL-881 . 

3. On the LCD touch screen (Figure 1.5), choose Factory Test. The Factory Test window appears (Figure 2.9). 

Factory Test

EDID Checksum: OK
HDCP 2.2: PASS

1

2

3

4

5

Text 
Output

Patterns

Color Bars

Red

Green

Color Bars

Color Bars

Resolutions

480P

1080I

1080P

2160P@50

2160P@60

Use the green buttons
To control

 

Figure 2.9. Factory Test Window 

Use the Up and Down arrows (green buttons in Figure 2.9) to switch among output signals to perform factory test. 

HDCP compliance information is displayed in the text output field. 
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3. Optional SL-881 AVG Software  
You must have purchased the SL-881 AVG software (p/n SL-881-SWUPG) from you distributor or Simplay Labs before 
you can complete the installation steps outlined below and obtain the license key to activate the features (SCDC, DDC, 
and EDID Editor)  

This section provides details on downloading and installing the optional SL-881 AVG software to your test computer. 

Note: Upon installation and licensing, control of the optional features resides with the 
application installed on your test computer. 

Overall, the optional SL-881 AVG software installation and licensing requires these procedures: 

1. Download the optional software from the website to your test computer. 

2. Install the software driver and the software. We recommend you installing the driver first. 

3. Purchase and activate the software license. The license must be purchased. 

 Downloading the SL-881 AVG Software 
The optional SL-881 AVG software can be downloaded from the Simplay website to your test computer. To download 
the software, see the Simplay Labs site, at: https://www.simplaylabs.com/Support/.  

3.1.1. Contents of the Software Package 

Download the firmware, software and driver (Figure 3.1):. Save*.zip to your test computer. Unzip the file. 

 

Figure 3.1. Inside the Software Package 

• The SL881_AVG_driver_installation folder contains driver installation files. Refer to Section 3.3 below for more 
details. 

• The SL881 AVG PC Software contains software installation files. Refer to Section 3.4 below for more details. 

• The SL-881 Firmware contains the binary file.   Refer to Appendix A for more details. 

 System Requirements 
Before installing the software, you need to confirm the system environment of your test computer. 

• A PC or laptop computer with Microsoft Windows 7 or Windows 8, 32 bit or 64 bit Operating System. 

• Minimum 4 GB, optimum 8 GB RAM. 

• 500 GB hard drive. 

https://www.simplaylabs.com/Support/
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 Installing the SL-881 AVG Driver 
You will need to install two drivers: first, the VCP (Virtual COM Port) driver, and then install the dpinst driver.  

Follow steps bellow to install the VCP driver and dpinst driver.  

1. Plug in the mini-USB cable (item 3 in Figure 1.4) and power on the SL-881. Open the SL881_AVG_driver_installation 
folder from your test computer. Click VCP_V1.4.0_Setup to install VCP driver (as shown in Figure 3.2)  

 

Figure 3.2. Install the VCP Driver 

2. After the VCP driver installation is completed, open readme.txt (Figure 3.2). Follow the steps in the “How to use” 
section in readme.txt to install the dpinst driver.  

Based on your Operating System: if you have 64-bit Windows, run dpinst_amd64.exe; if you have 32-bit Windows, 
run dpinst_x86.exe (Figure 3.3). 

 
Figure 3.3. Install the Dpinst Driver 

3. If the dpinst driver is installed correctly, you can see the SL-881 is recognized by the Device Manager (as shown in 
Figure 3.4). 

 

Figure 3.4. The SL-881 AVG Shown in Device Manager 
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 Installing the SL-881 AVG Software  
After installing the software driver, you need to install the software. Follow these steps to install the SL-881 AVG 
software. 

1. Open the SL881_AVG_software_installation folder from your test computer. Click setup.exe (as shown in Figure 3.5) 
to install the SL-881 AVG software. 

 

Figure 3.5. Locate and Open Setup.exe 

2. The Welcome to the Simplay AVG Setup Wizard dialog opens (as shown in Figure 3.6). Click Next. 

 

Figure 3.6. Welcome to the AVG Setup Wizard 

3. When the SL-881 AVG software installation is completed, the AVG application shortcut is created on your desktop 
(as shown in Figure 3.7). 

 

Figure 3.7. AVG Application Shortcut 
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 Licensing 
If you install the SL-881 AVG software for the first time, you need to set up the connection between the SL-881 and test 
computer, and then get an AVG software license.  

If you already have the AVG software license, you can set up the connection between the SL-881 and test computer, 
and use the AVG software directly. 

3.5.1. Getting License File 

You need to get and load the license file to activate the software. 

If you install the AVG software for the first time, follow these steps to get an AVG software license. 

1. Make sure the SL-881 is powered on and is connected to your test computer. Open the SL-881 Application shortcut 
from your test computer desktop (Figure 3.7). You get the main window of the AVG software (Figure 3.8).  

 

Figure 3.8. AVG Software Main Window on Test Computer 

2. Select File → Open Device → Connect Device.  

3. From the drop-down menu of this dialog, select the COM port shown in the Device Manager (Figure 3.9). 

 

Figure 3.9. Connect Device Dialog 

4. Click Open. 

5. A dialog pops up as shown in Figure 3.10. Click OK. 

 

Figure 3.10. No License File Found Dialog 
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6. From the AVG software main window (Figure 3.8), choose Help → License. The License Manager dialog appears 
(Figure 3.11). 

 

Figure 3.11. License Manager Dialog 

7. Click Create to generate a license requirement file (*.avg).  

8. The Windows Save as dialog pops up (Figure 3.12). Save this license requirement file to your test computer. 

 

Figure 3.12. The Windows Save As Dialog 

9. The Send License Requirement File dialog pops up (Figure 3.13). 

  

Figure 3.13. Send by Email Dialog 
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10. If you purchased your SL-881 directly from Simplay Labs, click To Simplay Labs. The Windows explorer pops up, 
pointing you to the license requirement file you previously saved. Then Microsoft Outlook window pops up. 
Manually attach the license requirement file (*.avg) which you previously saved to the email (Figure 3.14). Send it 
to tools@simplaylabs.com to request a license file (*.lic). Simplay Labs will send the license file back to you. 

 

Figure 3.14. License Requirement File to Simplay Labs 

If you purchased your SL-881 from a distributor/vendor, click To Distributor/Vendor. The Windows explorer pops 
up, pointing you to the license requirement file you previously saved. Then Microsoft Outlook window pops up. 
Manually attach the license requirement file (*.avg) which you previously saved to the email. Fill in your 
distributor/vendor’s email address. Send the email to your distributor/vendor. The distributor/vendor will forward 
this request to Simplay Labs and purchase the license key on your behalf. The distributor/vendor will send the 
license file back to you. 

3.5.2. Loading License File 

After getting a license file (*.lic), you need to load the license file to activate the software and yet to access enhanced 
test functionality of the SL-881. 

Follow these steps to load the license file. 

1. Save the license file to your test computer. 

2. Make sure your test computer is connected to the SL-881. 

3. Go back to the AVG software main window (Figure 3.8). Select File → Open Device → Connect Device. 

4. From the drop-down menu of this dialog (Figure 3.9), select the COM port shown in the Device Manager. 

5. Click Open. 

mailto:tools@simplaylabs.com
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6. No License File Found dialog pops up as shown in Figure 3.10. Click OK. After that, the Help → License menu item is 
enabled (Figure 3.15). 

 

Figure 3.15. License Menu Item Enabled 

7. Choose Help → License.  

8. The License Manager dialog appears (Figure 3.11). Click Load to load the license file (*.lic).  

9. After loading the license file, from the AVG software main window, the EDDC (SCDC) Compliance Testing, the DDC 
(I2C) Activity Monitor, and the Load or Edit Reference EDID options are enabled, as shown in Figure 3.16. The 
connection between the SL-881 and your test computer is completed. You can start using the SL-881 AVG software. 

 

Figure 3.16. Options Enabled in AVG Software Main Window 

Note: The Help → Support menu item (Figure 3.15) points you to the Simplay Labs website for 
technical support information.  
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4. Enhanced SL-881 AVG Test Mode  
After you purchased SL-881 software and install the software to the test computer, you can access those enhanced 
functionality of the SL-881 via your test computer, including performing EDDC (SCDC) compliance test, running Cable 
Loop-back test, monitoring DDC, and Editing EDID files, i.e. in its enhanced test mode. In this enhanced test based 
mode, use the SL-881, 5 V power, mini-USB cable, and HDMI cable to run those optional features. 

You can also control SL-881 with a console application of Windows to build SL-881 in your own automation test. 

Note: In this enhanced test mode, the LCD touch screen of the SL-881 is not operational. Most 
of the operation is performed on your test computer, unless there is message pop up 
prompting you to check the connections between the devices and the SL-881. 

 Performing EDDC Compliance Test 
1. From the AVG software main window of your test computer (Figure 3.16), click EDDC (SCDC) Compliance Testing. 

The EDDC Compliance Test window appears (Figure 4.1). 

2. From the EDDC Compliance Test window, select the Source DUT or Sink DUT radio button. 

 

Figure 4.1. EDDC (SCDC) Compliance Test Windows 

3. Click the Edit CDF button. CdfSource or CdfSink dialog pops up (Figure 4.2). You can customize the information to 
your need in the dialog. 
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Figure 4.2. CdfSource and CdfSink Dialogs 

4. After editing CDF variables, choose the items from the Source Tests area or the Sink Tests area (Figure 4.1). Click 
Run to run the selected items. 

5. A dialog pops up (Figure 4.3) asking you to connect the source or sink device to the test computer. After the 
connections are set up, click OK. 

 

Figure 4.3. Instruction Dialogs 

6. The selected tests run as shown below (Figure 4.4 and Figure 4.5). 
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Figure 4.4. EDDC Source Test with Log File 

 

Figure 4.5. EDDC Sink Test with Log File 

7. This step is Sink-Test-specific. 
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HDR Debug Test is one of the selected tests in the Sink Tests. When HDR Debug Test in Sink Tests is running, HDR 
Palette window pops up (Figure 4.6). 
HDR Debug Test is available only in the Sink Tests of the EDDC Compliance Test. This HDR Debug Test feature is 
available since SL-881 AVG software version 1.16 and hardware version 2.10015008. To download the software, 
refer to Downloading the SL-881 AVG Software. 

 

Figure 4.6. HDR Palette Window 

• Use SDR, HDR, or SMPTE radio button to select HDR infoFrame type. 

• Use Min R, Min G, and Min B buttons to set Primary points to reflect minimum Red, Green, and Blue 
coloremetry. 

• Use BT.601, BT.709, and BT.2020 buttons to set Primary points to reflect BT.601, BT.709, and BT.2020 
coloremetry.  

• Fill in Primary 1, Primary 2, Primary 3, and White Point fields to set Primary and White points with arbitrary 
values. The primary range is from 0 to 1.0. 

• Drag the circle points in the coordinate axis to set Primary and White points with arbitrary values. 

• Use slider bar Max, Min, MaxCLL, and MaxFALL to adjust luma parameters for HDR infoFrame. 

• Use Apply Changes button to control AVG platform to send new HDR infoFrame based on current selections. 

• Click Press Result PASS or Result FAIL button to end the test. Select which button that depends on customers’ 
expection of the sink device in this test. 
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8. After all the selected tests, for either Source Test or Sink Test in the EDDC compliance test, are completed, right 
click on the test case. Click “View DDC Waveform” to get a detailed DDC log (Figure 4.7). 

  

Figure 4.7. DDC Waveform Viewer 

9. Following is a sample DDC Waveform (Figure 4.8). 

Note: DDC Waveform viewer feature is available since SL-881 AVG software version 1.16 and 
hardware version 2.10015008. To download the software, refer to Downloading the SL-
881 AVG Software. 

 

Figure 4.8. Sample DDC Waveform 

• Use Open DDC Waveform button to load desired DDC waveform file. 

• Use “<-” and “->” buttons to view previous and next DDC waveform file. 

• Use “R” button to reset waveform displaying. 

• Use “<” and “>” buttons to navigate to previous and next DDC transaction. 

• Use “+” and “-“ buttons to zoom in and zoom out waveform displaying. 

10. When the EDDC compliance test completes, you can get a report file in HTML format by clicking the Report button 
(Figure 4.1). Following is a sample report (Figure 4.9). 
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Figure 4.9. Sample Test Report 
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 Running Cable Loop-back Test 
From the AVG software main window of your test computer (Figure 3.16), click Cable Loop-back Testing. The Cable 
Loop-back Test window appears (Figure 4.10). 

 

Figure 4.10. Cable Loop-back Test Windows 

There are two modes of Cable Loop-back test, single mode and batch mode. 

4.2.1. Single mode 

If you want to run the test in single mode, be sure NOT to check the Batch Test checkbox (bottom area in Figure 4.10).  

1. Select one or multiple items in the Test List area (Figure 4.11). 

 

Figure 4.11. Selected Items in Test List 
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2. Select how many times to repeat the test from the Repeat Times area. 

3. When Auto Increase checkbox is checked, Cable Name will be changed to Cable002 and increase after each 
complete test run.  

If the Auto Increase checkbox is not checked, Cable Name remains the same after each test. 

4. Click Run to run the items selected in Step 1. 

5. A dialog pops up (Figure 4.12) asking you to connect the cable device to the AVG platform. After the connections 
are set up, click OK.   

Note:  Connect the cable to the 6G Output port which supports Cable Loop-Back test.  The 3G Output port does not 
support Cable Loop-Back test. 

 

Figure 4.12. Cable DUT Test Setup 

6. Start running test for the selected items, as shown in Figure 4.13. 

 

Figure 4.13. Cable Loop Test in the Single Mode 
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7. When the Cable Loop-back test completes, you can get a formatted report file by clicking the Report button (Figure 
4.10). Following is a sample report (Figure 4.14). 

 

Figure 4.14. Sample Test Report 

4.2.2. Batch mode 

When running in the batch mode:  

1. Check the Batch Test checkbox (Figure 4.15). 

2. Select item(s) in the Test List area (Figure 4.15). 

3. Use Repeat Times listbox to select how many times to repeat the test. 

4. When Auto Increase checkbox is checked, Cable Name will be changed to Cable002 and increase after each 
complete test run.  

If the Auto Increase checkbox is not checked, Cable Name remains the same after each test. 

5. Click Run (Figure 4.10). 

6. Follow the instructions in the Test Log area to run the Cable Loop-back test (Figure 4.15). 
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Figure 4.15. Cable Loop Test in the Batch Mode 

Notes: 
Except running in Batch Test mode, you need to check all resolutions under Cable 
Loop-back Test window to see a result in Statistic Information area. 

7. After the testing is completed, click the item in the Test List area. The detailed result will be shown in the Detailed 
Result area (Figure 4.16). The green lines show the ideal signal waveform. The orange triangles show the noise 
jitter detected during the test. 

 

Figure 4.16. Cable Loop Test - Detailed Result Area 

8. Click the Report button (Figure 4.16). The Report file in HTML format is opened, and is automatically saved under 
Documents\SimplayAVG folder, name of which is CableTestSummary.html. 

9. Items in the Statistic Information area can be deleted (Figure 4.16) by selecting an item row and pressing the delete 
key (on your keyboard). 
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 Monitoring DDC 
1. From the AVG software main window of your test computer (Figure 3.16), click DDC (I2C) Activity Monitor. The DDC 

(I2C) Monitor window appears (Figure 4.17). 

2. From the DDC Monitor window, to decide which DDC bus to monitor, select the Rx Port, Tx Port, or External radio 
button. 

  

Figure 4.17. DDC Monitor Test Window 

• When you select the Rx Port radio button, a dialog pops up (Figure 4.18) asking you to connect the source 
device to the test computer. After the connection is set up, click OK. 

 

Figure 4.18. Input Port Monitor Instruction Dialog 
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• When you select the Tx Port radio button, a dialog pops up (Figure 4.19) asking you to connect the sink 
device to the test computer. After the connection is set up, click OK. 

 

Figure 4.19. Output Port Monitor Instruction Dialog 

• When you select the External radio button, a dialog pops up (Figure 4.20) asking you to connect the sink 
and source devices to the test computer. After the connection is set up, click OK. 

 

Figure 4.20. Pass Through Monitor Instruction Dialog 
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3. Click the Start Capture button to start the DDC monitor (Figure 4.21). DDC activities are logged and decoded.  

  

Figure 4.21. DDC Monitor Activities Window 

4. Check Scroll to Bottom option (Figure 4.21) to scroll the current log to the bottom. 

5. Check Collapse Same option (Figure 4.21) to collapse the same log. 

6. Click the Clean button (Figure 4.21) to clean the current log and decoding data displayed in the window when 
necessary. 

7. Click the Save button (Figure 4.21) to save the current log to local PC. 

8. Click the Load button (Figure 4.21) to load back log file from PC. 

9. Right click the log area, the area in red box (Figure 4.21), to show filter items. 

10. Check or uncheck the filter items (Figure 4.22) to show different DDC log accordingly. 
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Figure 4.22. DDC Log Filter 
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 Editing EDID 
1. From the AVG software main window of your test computer (Figure 3.16), click Load or Edit Reference EDID.  

2. From the EDID Editor window, select the EDID which you want to review, edit or program to the SL-881  
(Figure 4.23). 

 

Figure 4.23. EDID Editor Test Window 

• Reviewing EDID file 

To review selected EDID data, click the EDID Review button (Figure 4.23). EDID Review/Edit window 

appears (Figure 4.24). Contents of the EDID file are displayed. 
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Figure 4.24. EDID Review/Edit Window 

• Editing selected EDID data 

You can load your own EDID file. After that, you can edit the EDID file. 

o Loading Customer’s EDID data 

A. Choose Custom 1 from the Custom EDID area (Figure 4.23). If you need to load second EDID 
data, choose Custom 2. Custom 1 and Custom 2 can be chosen randomly. 

B. Click “...” (the blue box in Figure 4.23) to load customer’s EDID data, in either binary (*.bin) or 
text (*.txt) format. When customer’s EDID data is selected to load, the EDID Review button 
changes to the EDID Edit button in the EDID Editor Test window. 

C. Click the EDID Edit button. EDID contents are displayed in detail in the EDID Review/Edit window 
(Figure 4.24). 

o Modifying the EDID contents. 

A. Select the tab, contents of which you want to modify (Figure 4.24). 

B. Modify the data on that tab. 

C. Click the Update Data button to apply the changes. If you need to go back to the original data, 
click the Reload Data button to reload the original EDID contents. 

D. Click Save as to save the modified EDID contents. You can save the contents in text (*.txt) or 
binary (*.bin) format. 
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• Programming EDID file 
To program selected EDID data into EDID contents of the SL-881 HDMI IN port, click the EDID Program 

button (Figure 4.23). Once the programming completes successfully, a dialog pops up (Figure 4.25). Click 

OK. 

 

Figure 4.25. EDID Program Done Dialog 

 Running with Console Application of Windows 
This section describes how to use a console interface to control the SL-881 AVG platform. 

Note: This function is available since SL-881 AVG software version 1.16 and hardware version 
2.10015008. To download the software, refer to Downloading the SL-881 AVG Software. 

4.5.1. Hardware and Software Requirements 

The following hardware and software are required to run the SL-881 with console control: 

• Hardware requirements: 
o SL-881 AVG platform (Figure 1.1) 
o USB A to USB mini-B cable 

• Software requirements: 
o Console application of Windows (cmd.exe) 
o AVG_Console.exe (Figure 4.26) 

 

Figure 4.26. AVG_Console.exe 

4.5.2. Getting Started 

Follow the procedures described in this section to setup the console application. 

1. Power on the SL-881. 

2. Connect mini-B cable from PC to the SL-881. 

3. Invoke Command Prompt window. Press “Win + R” to start “cmd.exe” (Figure 4.27). 

  

Figure 4.27. Running cmd.exe 
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4. From the Windows explorer, navigate to the folder where AVG_Console.exe locates.  

A typical location is “C:\Program Files (x86)\Simplay Labs\Simplay AVG”. 

Manually typing the path of AVG_Console.exe in the Command Prompt window (Figure 4.28). 

  

Figure 4.28. Entering AVG_Console.exe Path 
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5. Run “AVG_Console.exe” with parameters (Figure 4.29). Supported parameters are listed in Table 4.1. 

 

Figure 4.29. Running AV_Console.exe with Parameters 
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Table 4.1. Supported Parameters 

Features -Parameter -Argument Details Returns 

Video 
Transmitting 

-gen 

-r 

1 : 640x480p60 

2/3: 720x480p60 

4: 1280x720p60 

16: 1920x1080p60 

17/18: 720x576p50 

19: 1280x720p50 

31: 1920x1080p50 

95: 3840x2160p30 

97: 3840x2160p60 

0: Success 

-1: Failed 

-hdcp 0/1/2/3 

0: Auto 

1: Force 1.4 

2: Force 2.2 

3: Off 

-cs 0/1/2/3 

0: RGB 

1: YCbCr 4:2:0 

2: YCbCr 4:2:2 

3: YCbCr 4:4:4 

-st 0/1/2 

0: Auto 

1: HDMI 

2: DVI 

-cd 0/1/2 

0: 8 bit 

1: 10 bit 

2: 12 bit 

-p 0/1/.../22 

0: color_bar75  1: half_red75 

2: half_green75  3: half_blue75 

4: half_magenta75  5: half_cyan75 

6: half_yellow75  7: half_white75 

8: black   9: checkerboard 

10: bluescreen  11: doublepluge 

12: sharpness  13: colortint 

14: grayramp  15: evothvline 

16: freqsweep  17: frmgeom 

18: rgbgray  19: rgb3bars 

20: half_clrbars75  21: diagram 

22: hdrdemo 

Cable Loop Test -cable 

-r 

1 : 640x480p60 

2/3: 720x480p60 

4: 1280x720p60 

16: 1920x1080p60 

95: 3840x2160p30 

97: 3840x2160p60 

32-bit value:  

Bits 7-0 channel 0 result count  

Bits 15-8 channel 1 result count  

Bits 23-16 channel 2 result count 

Bits 24-31 flags 

25,24: (0- Inconclusive;  1- Pass;  2- Fail;  3- Pass_Margin) 

26: DDC connection error 

27: HPD connection error 

28: +5 V connection error 

29: resolution mismatch 

-conn 0/1 
0: Skip cable connection check 

1: Run with cable connection check 

-hdcp 0/1 
0: Skip HDCP check 

1: Run with HDCP check 
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Table 4.1. Supported Parameters (Continued) 

Features -
Parameter 

-Argument Details Returns 

Video Analyze -ana 

5v Get input 5 V state 
0: 5 V Off 
1: 5 V On 

stype Get signal type 

0: None 
1: DVI 
2/3: HDMI 
4: MHL 

hdcp Get HDCP state 
0: Off   1: HDCP 1.4 pass 
2: HDCP 2.2 pass   3: Authenticating 
4: Failed 

freq Get character frequency Return value in unit Hz 

intl Get interlaced mode 
0: Progressive 
1: Interlaced 

hpol Horizontal sync polarity 
0: Negative 
1: Positive 

htot Horizontal total pixels Return value in pixel count 

hact Horizontal active pixels Return value in pixel count 

hsnc Horizontal sync pixels Return value in pixel count 

hfrt Horizontal front porch pixels Return value in pixel count 

vpol Vertical sync polarity 
0: Negative 
1: Positive 

vtot Vertical total pixels Return value in pixel count 

vact Vertical active pixels Return value in pixel count 

vsnc Vertical sync pixels Return value in pixel count 

vfrt Vertical front porch pixels Return value in pixel count 

vic VIC code in AVI infoFrame As defined in CEA861 Spec 

ar Aspect ratio 
0: None   1: 4:3 2:16:9 
3: 64:27   4: Square pixel 

cs Color space 
0: RGB   1: YC444 
2: YC422   3: YC420 

cd Color depth 
0: None   1: 8bits 
2: 10bits   3: 12bits 

3d 3D information 
0: None   1: Frame 
Sequential 
3: TopBottom  8: SideBySide 

rpt Pixel repetition 
0/1: No repeat 
N: Repeat (N-1) times 

ainfo AVI infoFrame raw data 10 bytes (as defined in HDMI Spec) 

csbits Audio Channel Status data 10 bytes (as defined in 60958 Spec) 

hdrt Get HDR infoFrame Type 
0: None   1: Tranditional SDR 
2: Tranditional HDR  3: SMPTE 2084 
4: Hybird Log-Gamma 

hdrd HDR infoFrame raw data 32 bytes (as defined in HDMI Spec) 

all 
Return all above result and 
decode them as messages 

— 

Load EDID -load {path} 
String {path} where EDID data 
is located, supporting 
“.bin/.hex/.edi/.txt” formats 

0: Success 
other: Failed 

5 V Control -out5v -0/1 
Disable/enable HDMI output 
port 5 V power 

0: Success 
other: Failed 
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HPD Control -inhpd -0/1/time 

0: Disable 

1: Enable 

time-toggling HPD for “time” 
ms 

0: Success 
other: Failed 

4.5.3. Resolution Parameter Description 
Value Description  Value Description 

1 640x480p60  31 1920x1080p50 

2 720x480p60 (4:3)  32 1920x1080p24 

3 720x480p60 (16:9)  33 1920x1080p25 

4 1280x720p60  34 1920x1080p30 

5 1920x1080i60  93 3840x2160p24 

6 1440x480i60 (4:3)  94 3840x2160p25 

7 1440x480i60 (16:9)  95 3840x2160p30 

16 1920x1080p60  96 3840x2160p50 

17 720x576p50 (4:3)  97 3840x2160p60 

18 720x576p50 (16:9)  98 4096x2160p24 

19 1280x720p50  99 4096x2160p25 

20 1920x1080i50  101 4096x2160p50 

21 1440x576i50 (4:3)  100 4096x2160p30 

22 1440x576i50 (16:9)  102 4096x2160p60 

 

4.5.4. Pattern Parameter Description 
Value Description  Value Description 

0 color_bar75  12 sharpness 

1 half_red75  13 colortint 

2 half_green75  14 grayramp 

3 half_blue75  15 evothvline 

4 half_magenta75  16 freqsweep 

5 half_cyan75  17 frmgeom 

6 half_yellow75  18 rgbgray 

7 half_white75  19 rgb3bars 

8 black  20 half_clrbars75 

9 checkerboard  21 diagram 

10 bluescreen  22 hdrdemo 

11 doublepluge  

 

4.5.5. Option to Control multi-AVG Platforms 
Features -Parameter -Argument Details 

Multi-AVG 
Control 

-port COM* 
When multi-AVG is connected to one PC, use this feature to 
indicate which AVG to control (*-COM number) 

 

Besides parameters listed in Table 4.1, you can indicate which exactly AVG platfomr to control with this “-port” 
argument. For example, when you connect two AVG platforms to one PC, one is connected to COM port COM23 and 
the other is to COM port COM26. You can control which one you want to specify its COM port number. 
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4.5.6. Examples of Parameter Usages 

In the Command Prompt window, you can run “AVG_Console.exe” with different parameters. 

Following are the examples of parameter usage for different purposes: 

Purpose Command 

To generate resolution 1920 x 1080p @ 60 Hz >AVG_Console.exe  –gen  –r  16 

To generate resolution 4K YCbCr 4:2:0 >AVG_Console.exe  –gen  –r  97  –cs  1 

To run a “Cable Loop Test” for 4K @ 60 Hz resolution >AVG_Console.exe  –cable  –r  97 

To run a “Cable Loop Test” for 4K @ 60 Hz resolution without cable 
connection checking 

>AVG_Console.exe  –cable  –r  97  –conn  0 

To generate HDR pattern with 1080p @ 60 Hz, size percentage = 50%, 
IRE percentage = 70%, HDR infoFrame type = SMPTE 

>AVG_Console.exe  –gen –r 16 –p 7 –pw1 5 –pw2 7 –
hdr  

To get input signal timing information, e.g. horizontal active pixels’ 
count 

>AVG_Console.exe  –ana hact 

To set output HDMI1 port 5 V to “off” state >AVG_Console.exe  –out5v 0 

To toggle input HDMI port HPD for 300 ms >AVG_Console.exe  –inhpd 300 

To load EDID data located at “C:\test\myEDID.bin” >AVG_Console.exe  –load C:\test\myEDID.bin 

To control 2nd AVG platform which occupying COM port 29 >AVG_Console.exe  –gen –r 16 –port COM29 
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Appendix A. Internal Firmware Upgrade 
If you received firmware upgrade notification from Simplay Labs, or if you find issues or problems in the firmware, use 
the files in the firmware folder to make upgrade. 

You can download the latest SL-881 AVG firmware installation package from Simplay Labs website 
http://www.simplaylabs.com/support/product_support.aspx. Choose “SL-881”. There is only one package in the *zip 
downloaded (Figure A.1). The package contains firmware installation files.  

 

Figure A.1. SL-881 Firmware Installation Package 

The SL881_AVG_firmware_installation folder contains one AVG.bin file (Figure A.2), which is to be used below. 

 

Figure A.2. SL-881 Firmware binary file 

Follow the steps below to perform the SL-881 firmware update. 

1. Copy the AVG.bin files you downloaded to the SD card. 

2. Plug in the SD card and power on the SL-881. 

3. The SL-881 LCD touch screen main window appears (as shown in Figure 1.5). From now on, all the operation is 
performed on the SL-881 AVG. 

4. Choose Settings. 

5. In the System Settings window (Figure A.3), you can see the current version information. Write down the System 
FW Version, Video Transceiver Version and RTL Version for a later check. 

System Settings

Hardware Version: 1.1 

Product Info

System FW Version:

Copyright © Simplay 2015

www.simplaylabs.com

Video Transceiver Version: 006

RTL Version: 005

1.0

 

Figure A.3. System Settings Window Shown on the SL-881 LCD Touch Screen  

6. Power off the SL-881. 

7. Pin and hold the UPG button (item 11 in Figure 1.4) of the SL-881. Power on the SL-881. 

http://www.simplaylabs.com/support/product_support.aspx
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8. Firmware update starts running automatically (Figure A.4). You can release the UPG button now. 

Updating Firmware

Burn AVG.bin to Flash ………………

……

 

Figure A.4. Image Update Window Shown on the SL-881 LCD Touch Screen 

9. After that step is done, Video Transceiver and RTL firmware will be updated automatically as shown in Figure A.5.   

Firmware Update

51%

Updating Video Transceiver FW ...

Firmware Update

28%

Updating RTL ...

 

Figure A.5. Transceiver FW and RTL Updating Windows shown on the SL-881 LCD Touch Screen 

10. After all firmware is updated successfully, follow the instruction to power off then power on the SL-881, as shown 
in Figure A.6. 

Firmware Update

100%

Firmware updated successfully.
Power off

then power on the AVG platform.

 

Figure A.6. Image Update Completed Window Shown on the SL-881 LCD Touch Screen 
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To confirm whether or not the firmware update is successful, follow the steps below: 

1. After you power on the SL-881 again, go back to the LCD touch screen main window (Figure 1.5). Click Settings. 

2. The System Settings window appears. Compare the System FW Version, Video Transceiver Version and RTL Version 
in the current window (Figure A.7) with the one (Figure A.3) you have written down. If the version number changes 
as expected, the firmware is updated successfully. 

 

System Settings

Hardware Version: 1.1 

Product Info

System FW Version:

Copyright © Simplay 2015

www.simplaylabs.com

Video Transceiver Version: 007

RTL Version: 006

1.1

 

Figure A.7. System Settings Window after Successful Firmware Updating  
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Appendix B. LCD Touch Screen Position Calibration 
The SL-881 AVG LCD touch screen has been calibrated before shipping out. In case you need to calibrate touch screen 
position, follow steps below. All the operation in this section is performed on the SL-881. 

1. Press the UPG button (item 11 in Figure 1.4) first, and then press the Reset button (item 13 in Figure 1.4) to reset 
the SL-881. After the SL-881 completes resetting, the Touch Screen Calibration window appears. See Figure B.1. 

Touch Screen Calibration

At first time, you need to 
calibrate the Touch Screen.

Please press the touch screen to 
continue...

 

Figure B.1. Touch Screen Calibration Window Shown on the SL-881 LCD Touch Screen 

2. Touch any position on the touch screen to start the calibration. 

3. A message appears on the top left corner on the touch screen (Figure B.2). Follow the instruction, press the circle. 

Runtime calibration,
please touch the screen 
at the center of the ring.

Press here
(upper left position)

 

Figure B.2. Click Circle on the Top Left Corner 

4. After that, another message appears on the lower right corner on the touch screen (Figure B.3). Follow the 
instruction, press the circle. The touch screen position calibration is finished. 

Runtime calibration,
please touch the screen 
at the center of the ring.

Press here
(lower right position)  

Figure B.3. Click Circle on the Lower Right Corner 

5. After the position calibration is completed, the SL-881 will go back to the LCD Touch Screen main window  
(Figure 1.5). 
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HDMI CTS High-Definition Multimedia Interface Version 2.0 Generic Compliance Test Specification, October 4, 2013 

 



SL-881 6G Handheld HDMI/MHL Audio and Video Generator/Analyzer   
User Guide 
 

52 © 2016-2017 Simplay Labs, LLC., Simplay-UG-02001-E 
All rights reserved. CONFIDENTIAL 

Revision History 

Revision E, April 2020 

Summary of Changes and Additions: 

Updated the Simplay Labs hypertext links in the document. 
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Sink Device in Stand-alone Mode. 
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General Warranty Terms 

Simplay Labs, LLC., (Simplay Labs), a Lattice Semiconductor company, offers a limited warranty for its Simplay Labs products. Any product first sold to 
your business is guaranteed to be free from defects in both components and workmanship under regular uses. The warranty period commences on 
the date the item ships. 

Attention: Your invoice with the date of purchase, model number and serial number of the product is your proof of the date of purchase. 

This International Limited Warranty is applicable and shall be honored in every country where Simplay Labs or its Authorized Service Providers offer 
warranty service subject to the terms and conditions provided in this International Limited Warranty Statement. 

Simplay Labs Products Warranty Period 

The warranty terms for Simplay Labs products are: Domestic & Asia  EU & UK  

 1 Year 2 Year  

The International Limited warranty does not affect your statutory rights. 

System Warranty 

During the warranty period, the defective hardware of Simplay Labs products will be either repaired or replaced, with new or like new products, at 
the discretion of Simplay Labs except in the cases listed in the Limitation of Liability Clause of this document. 

This International Limited Warranty covers the costs of service parts and labor required to restore your product to fully functional condition. Simplay 
Labs will, at its discretion, repair or replace any defective products or parts thereof covered by this International Limited warranty with refurbished 
parts of the product that are equivalent to new or like new products in both functionality and performance. A product or part that is repaired or 
replaced under this International Limited warranty shall be covered for the remainder of the original warranty period applying to the product or part, 
or for90-days, whichever expires last. All exchanged parts and products under this International Limited Warranty will become the property of 
Simplay Labs. 

Software Limited Warranty 

Simplay Labs offers no warranty, either explicitly expressed or implicitly implied, for any pre-installed software, its quality, performance, 
functionality, or compatibility for a particular purpose. Nor does Simplay Labs warrant that the functions contained in the software will meet specific 
requirements or that the operation of the software will be uninterrupted or error-free. Thus, the software is sold ‘as is” unless otherwise explicitly 
stated in writing. 

Obtaining the Warranty Service 

Warranty service or Returned Merchandise Authorization (RMA) under this International Limited Warranty will be honored only if claims are made 
within the warranty period. For notifications to Simplay Labs or products outside the warranty period, the process will be the same, but charges may 
apply. Contact details may be obtained on Simplay Labs website (https://www.simplaylabs.com/Support/Warranty/). Customers are requested to 
perform the following actions before claiming Simplay Labs product as defective: 

Owner must notify Simplay Labs, during the warranty period, in writing of alleged defect, and allow Simplay Labs a reasonable opportunity to inspect 
the allegedly defective product; 

No Product may be returned without Simplay Labs’ consent, The Simplay Labs RMA# must accompany all returns, and all returns must be delivered 
to Simplay Labs within the warranty period; 

Owner may, then at its own expense, return the allegedly defective Product, freight pre-paid and in the original packaging, accompanied by a brief 
statement explaining the alleged defect to Simplay Labs; 

If Simplay Labs determines that any returned Product is not defective, or if Simplay Labs determines that the defect is not covered by the warranty, 
Simplay Labs will return the Product to the Owner at Owner’s expense, freight collect, and Owner agrees to pay Simplay Labs’ reasonable cost of 
handling and testing; 

Upon determining that a returned product is defective, to receive warranty service Owner will need to present the invoice showing the original 
purchase transaction. If shipping the product, Owner will need to package it carefully and send it, transportation prepaid by a traceable, insured 
method, to the Simplay Labs Service Center. Package the product using adequate padding material to prevent damage in transit. The original 
container is ideal for this purpose. Include the RMA#, your name, return shipping address, email address and telephone number where you may be 
reached during business hours, inside the shipping package with the unit. Any replacement unit will be warranted under these Terms and Conditions 
for the remainder of the original warranty period or ninety (90) days whichever is longer. 

Make sure to back up any important data and remove all confidential, proprietary information. Neither Simplay Labs nor its authorized service 
centers are responsible for damages to or loss of any programs, data, or other software and files in the items. 

Refer to user manual enclosed within the product package and/or information on https://www.simplaylabs.com/Support/Documentation/ for 
important tips on how to operate and troubleshoot the product 

International Warranty 

Warranty may be valid when a Simplay Labs product is purchased in one country and transferred to another country, without voiding the warranty. 
Please be advised that service availability and response time may vary from country to country. 

Simplay Labs is not responsible for any export and import control issues, handling fees, tariffs, import duties, and all other related fees where owner 
is responsible for shipping its products. 

https://www.simplaylabs.com/Support/Warranty/
https://www.simplaylabs.com/Support/Documentation/
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Disclaimer of Warranty 

THIS WARRANTY IS EXPRESSED IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING THE IMPLIED WARRANTY OF 
MERCHANTABILITY, THE IMPLIED WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES ON SIMPLAY 
LAB’S PART, AND IT NEITHER ASSUMES NOR AUTHORIZES ANY OTHER PARTY TO ASSUME FOR SIMPLAY LABS ANY OTHER LIABILITIES. THE 
FOREGOING CONSTITUTES THE BUYER’S SOLE AND EXCLUSIVE REMEDY FOR THE FURNISHING OF DEFECTIVE OR NONCONFORMING PRODUCTS AND 
SIMPLAY LABS WILL NOT IN ANY EVENT BE LIABLE FOR COST OF SUBSTITUTE OR REPLACEMENT, COST OF FACILITIES OR SERVICE, DOWNTIME COSTS, 
LOSS OF PROFITS, REVENUES OR GOODWILL, RELIANCE DAMAGES, LOSS OF DATA, LOSS OF USE IF OR DAMAGE TO ANY ASSOCIATED EQUIPMENT, OR 
ANY OTHER INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES BY REASON OF THE FACT THAT SUCH PRODUCTS WILL HAVE BEEN 
DETERMINED TO BE DEFECTIVE OR NONCONFORMING. 

THE RIGHTS AND OBLIGATIONS OF THE PARTIES UNDER THIS AGREEMENT SHALL NOT BE GOVERENED BY THE PROVISIONS OF THE 1980 U.S. 
CONVENTION ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS OR THE UNITED NATIONS CONVENTION ON THE LIMITATION PERIOD IN 
THE INTERNATIONAL SALE OF GOODS, AS AMENDED (COLLECTIVELY, THE “CONVENTIONS”); RATHER, THE RIGHTS AND OBLIGATIONS OF TH 
EPARTIES HSALL BE GOVERNED BY THE LAWS OF THE SATE OF CALIFORNIA, INCLUDING ITS PROVISIONS OF THE UNIFORM COMMERCIAL CODE. FOR 
THE AVOIDANCE OF DOUBT, THE CONVENTIONS ARE HEREBY EXCLUDED. 

This Limited Warranty gives you specific legal rights. You may also have other rights that may vary from state to state or from country to country. You 
are advised to consult applicable state or country laws for full determination of your rights. 

Simplay Labs products are not designed for any “critical applications.” ”Critical applications” shall mean life support systems, medical applications, 
connections to implanted medical devices, commercial transportation, nuclear facilities or systems or any other applications where product failure 
could lead to injury to persons or loss of life or property damage. 

Copyright Notice 

Copyright © 2016-2020 Simplay Labs, LLC., a Lattice Semiconductor company. All rights reserved. 

Trademark Acknowledgment 

Simplay®, Simplay HD®, Simplay HD logo, Simplay Labs™ and Simplay Labs logo are trademarks or registered trademarks of Silicon Image, Inc. in the 
United States and/or other countries. HDMI® and the HDMI logo are trademarks or registered trademarks of, and are used under license from, HDMI 
Licensing, LLC. in the United States or other countries. MHL® and the MHL logo are trademarks or registered trademarks of, and are used under 
license from, MHL, LLC. in the United States or other countries. All other trademarks and registered trademarks are the property of their respective 
owners in the United States and/or other countries. 

HDMI Licensing, LLC; MHL, LLC, and Simplay Labs, LLC are wholly owned subsidiaries of Lattice Semiconductor, Inc. 

The absence of a trademark symbol does not constitute a waiver of the trademarks owner’s rights or other intellectual property rights with regard to 
a product name, logo or slogan. 

Export Controlled Document  

This document contains materials subject to the Export Administration Regulations. Transfer of this information by any means to a foreign 
destination may require a license. These materials shall not, in the absence of authorization under U.S. and local law and regulations, as required, be 
used by or exported or re-exported to (i) any U.S. sanctioned or embargoed country, or to nationals or residents of such countries; or (ii) any person, 
entity, organization or other party identified on the U.S. Department of Commerce's Denied Persons or Entity List, the U.S. Department of Treasury's 
Specially Designated Nationals or Blocked Persons List, or the Department of State's Debarred Parties List, as published and revised from time to 
time; (iii) any party engaged in nuclear, chemical/biological weapons or missile proliferation activities; or (iv) any party for use in the design, 
development, or production of rocket systems or unmanned air vehicles. 

Limitation of Liability 

Simplay Labs reserves the rights to refuse warranty service of products under disputable conditions. Simplay Labs also holds the rights to declare final 
decision whether products are within warranty conditions. The following actions and damages will result in voiding the limited warranty: 

Damage caused by act of nature, such as fire, flood, wind, earthquake, lightning, etc. 

Damage or incompatibility caused by failure to perform a proper installation or to provide an appropriate operational environment for the product, 
including but not limited to unstable wired/ wireless network connection and phone lines, bad grounding, external electro-magnetic fields, direct 
sunlight, high humidity and vibration. 

• Damage caused by impact with other objects, dropping, falls, spilled liquids, or submersion in liquids. 

• Damage caused by unauthorized repair or disassembling of the product. 

• Damage caused by any other abuse, misuse, mishandling, or misapplication. 

• Damage caused by third party peripherals (including but not limited to visible damages on motherboard or other electronic parts of the product 
such as burn spots after electric discharge, melting, fusing, splitting, etc.). 

• Any unauthorized software or modification of built-in software not approved by Simplay Labs. 

• The serial number of the product (or serial number stickers of its parts) has been modified, removed, blurred or damaged. 

• Cracks and scratches on LCD and plastic material as well as other defects caused by transportation, handling or customer abuse.
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